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Symbols and Abbreviations 
The following symbols and abbreviations, and others approved for the Système International d'Unités (SI), are used 
without definition in the following reports by the Divisions of Sport Fish and of Commercial Fisheries: Fishery 
Manuscripts, Fishery Data Series Reports, Fishery Management Reports, and Special Publications. All others, 
including deviations from definitions listed below, are noted in the text at first mention, as well as in the titles or 
footnotes of tables, and in figures or figure captions. 
Weights and measures (metric)  
centimeter cm 
deciliter  dL 
gram  g 
hectare ha 
kilogram kg 
kilometer km 
liter L 
meter m 
milliliter mL 
millimeter mm 
  
Weights and measures (English)  
cubic feet per second ft3/s 
foot ft 
gallon gal 
inch in 
mile mi 
nautical mile nmi 
ounce oz 
pound lb 
quart qt 
yard yd 
  
Time and temperature  
day d 
degrees Celsius °C 
degrees Fahrenheit °F 
degrees kelvin K 
hour  h 
minute min 
second s 
  
Physics and chemistry  
all atomic symbols  
alternating current AC 
ampere A 
calorie cal 
direct current DC 
hertz Hz 
horsepower hp 
hydrogen ion activity pH 
     (negative log of)  
parts per million ppm 
parts per thousand ppt, 
 ‰ 
volts V 
watts W 

General  
Alaska Administrative  
    Code AAC 
all commonly accepted  
    abbreviations e.g., Mr., Mrs., 

AM, PM, etc. 
all commonly accepted  
    professional titles e.g., Dr., Ph.D.,  
 R.N., etc. 
at @ 
compass directions:  

east E 
north N 
south S 
west W 

copyright  
corporate suffixes:  

Company Co. 
Corporation Corp. 
Incorporated Inc. 
Limited Ltd. 

District of Columbia D.C. 
et alii (and others)  et al. 
et cetera (and so forth) etc. 
exempli gratia  
    (for example) e.g. 
Federal Information  
    Code FIC 
id est (that is) i.e. 
latitude or longitude lat or long 
monetary symbols 
     (U.S.) $, ¢ 
months (tables and 
     figures): first three  
     letters Jan,...,Dec 
registered trademark  
trademark  
United States 
    (adjective) U.S. 
United States of  
    America (noun) USA 
U.S.C. United States 

Code 
U.S. state use two-letter 

abbreviations 
(e.g., AK, WA) 

Mathematics, statistics 
all standard mathematical 
    signs, symbols and  
    abbreviations  
alternate hypothesis HA 
base of natural logarithm e 
catch per unit effort CPUE 
coefficient of variation CV 
common test statistics (F, t, χ2, etc.) 
confidence interval CI 
correlation coefficient  
   (multiple) R  
correlation coefficient 
    (simple) r  
covariance cov 
degree (angular) ° 
degrees of freedom df 
expected value E 
greater than > 
greater than or equal to ≥ 
harvest per unit effort HPUE 
less than < 
less than or equal to ≤ 
logarithm (natural) ln 
logarithm (base 10) log 
logarithm (specify base) log2, etc. 
minute (angular) ′ 
not significant NS 
null hypothesis HO 
percent % 
probability P 
probability of a type I error  
   (rejection of the null 
    hypothesis when true) α 
probability of a type II error  
   (acceptance of the null  
    hypothesis when false) β 
second (angular) ″ 
standard deviation SD 
standard error SE 
variance  
     population Var 
     sample var 
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PURPOSE 
The Alaska Department of Fish and Game conducts annual fall pot surveys in Southeast Alaska to assess Tanner crab 
health indices and calculate catch per unit of effort (CPUE) data. This information is used in Tanner crab stock 
assessment and is used to provide management recommendations for the commercial fishery. 

Keywords: Pot survey, Tanner crab, Chionoecetes bairdi, abundance, bycatch, Southeast Alaska, stock 
assessment 

OBJECTIVES 
PRIMARY 

1. Capture and collect biological information on Tanner crab from 4 survey areas in the 
central and northern portion of Southeast Alaska for model-based biomass estimation. 

2. Obtain a pre-season index of legal Tanner crab pre-recruit male and female abundance and 
assess female reproductive status. 

3. Determine if the minimum biomass threshold of mature males for a commercial fishery 
opening has been exceeded, and the number of fishing days that will be allowed.  

4. Capture and collect biological information on other commercial crab bycatch species, such 
as king crab and Dungeness crab.  

SECONDARY 
5. Maintain long-term data set on bottom temperature (from HOBO temperature tidbits) for 

future climate analysis and comparisons. 
6. Collect chela height ratios of male Tanner crab to estimate size at maturity. 
7. Visual identification of bitter crab prevalence. 

BACKGROUND 
The survey is currently conducted in the central and northern portion of Southeast Alaska in 4 
survey areas: Icy Strait, Thomas Bay, Holkham Bay, and Glacier Bay (Figure 1, Table 1). 
Previously surveyed areas included Port Camden and Stephens Passage; these areas have been 
excluded from the assessment since 2015.  
A range of 52 to 78 pots are set in each survey area, dependent on the size of the area and time 
needed to set, pull, and sample pots. Catch per unit effort (CPUE) of mature male crab is 
incorporated into a model to produce estimates of population size for each surveyed area. 
Population size is estimated using a three-stage catch survey analysis model (CSA) that tracks 3 
recruit categories (classified using size and shell condition; Table 2) of male crabs over the range 
of survey years, which in most areas began in 1997 through the present, to estimate the current 
abundance of mature and legal male crab in each area. 
In addition to estimating abundance, other factors that contribute to the overall health of the 
population are examined, including CPUE of juvenile male and female crab, egg condition, clutch 
fullness, and size distributions. Estimates of harvestable surplus are generated for each survey area 
and expanded using the mean proportion of harvest occurring in the surveyed areas to produce a 
regional biomass estimate for mature male crab. The regional mature male biomass estimate is 
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compared to a regulatory threshold of 2,300,000 lb (5 AAC 35.113), which is the minimum level 
for the commercial fishery to open. Survey results are also used to set the season length; additional 
fishing days are added when the estimated biomass of mature males exceeds 5,500,000 pounds. 

METHODS 
SURVEY DESIGN 
Southeast Alaska Tanner crab stocks are assessed using a stratified random sampling design. Four 
important fishing locations in Southeast Alaska are surveyed annually at the smallest tidal range 
in late September and October of each year. Commercially important bycatch species are counted, 
recorded, and returned to the sea (Table 3). All king, Tanner, and Dungeness crabs are retained for 
collection of biological information and then returned to the sea.   
Updates to the survey design were performed prior to the 2013 survey. The survey areas were 
stratified based on total crab abundance from previous surveys and depth data obtained from 
NOAA bathymetric maps. These methods were similar to the density stratification currently in 
place for red king crab stock assessment survey (Clark 2008). The stratification provides 5 density 
strata in a design that minimizes variability within strata, providing a statistically robust estimate 
of CPUE for use in the CSA model; this will provide more confidence in the biomass forecasts.   
Survey methods were first detailed in Tanner crab pot survey methods for Southeast Alaska 
(Bednarski et al. 2008). This Regional Operational Plan updates those methods for the 2024 
through 2028 field seasons. 

POT LOCATIONS 
Pot locations are selected within 5 density strata through a stratified random sampling design. The 
number of pots within each stratum is determined using a Neyman allocation based on the variance 
of total crab CPUE estimates by strata using survey data from 2013 through 2015; this information 
is updated with new data every 3 years (Cochran 1977). The allocation was updated for the 2024 
survey season, using data from 2021 to 2023; the next update is scheduled for 2028. The 2024 pot 
allocation was based on previous area calculations for Glacier Bay. Updating the size of the area 
is needed for future allocation calculations. The total number of pots within each survey area is 
determined based on logistics and the time that the crew can efficiently sample and set pots. Exact 
pot locations are determined using randomly generated locations within each stratum, with a 
minimum distance of 0.1 nautical miles between pots using ArcGIS (Appendices E2, F2, G2, and 
H2). Extra pot locations are for each area, in the event that there may be conflicts with gear from 
concurrent fisheries in the vicinity or if set locations are otherwise unattainable. 

SETTING AND PULLING 
Approximately 26 pots are deployed each day (Appendix D1); setting and hauling times will be 
recorded for each pot on the “Crab Pot Set Form” (Appendix B1). Pots will be set between 12:00 
and 18:00 hours and pulled between 07:00 and 13:00 hours; pots are generally hauled in the same 
order as they are set and soak times range from 16–20 hours. Tanner crab pot soak time 
experiments conducted in 2004 and 2005 in Icy Strait and Excursion Inlet found no gear saturation 
occurring with the gear and standard soak period used in this survey (Rumble et al. 2008).  
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POT GEAR AND BAIT 
Conical, top-loading commercial crab pots with an eighty-eight-inch diameter and closed escape 
rings will be used for the survey. Bio-twine (30-thread untreated cotton twine) will be laced 
through an 18-inch opening on a side wall of each pot. Pots will be baited with one ½ round of 
pink salmon and approximately 4 pounds of frozen, winter-caught Alaska bait herring (preferably 
caught the same year as the current survey) and chopped within 24-hours of use. Two bait 
containers, on opposite sides of the pot and each filled with approximately 2 pounds of chopped 
herring, will be used for each pot along with the one ½ round of pink salmon. The bait jars will be 
suspended so that the top of the bait jar is approximately the same height as the bottom of the pot 
cone and about halfway between the cone and the exterior webbing. The bio-twine will be replaced 
on all pots prior to setting gear on the first day of leg 1 of the survey in each year.  
HOBO Tidbit® temperature loggers will be individually attached to a numbered buoy tag and to 
all pots with zip ties prior to the first set on each leg of the survey. Tidbits should be attached to 
pots so that the tag number is facing out and visible to crew on deck. Temperature is recorded at 
hourly intervals to the nearest thousandth °C. All tidbits should be removed from the pots at the 
time each pot comes aboard for the last time, and the information downloaded at the end of each 
survey leg. Temperature logger protocols are found in Appendix A.  
Setting and pulling the gear is the responsibility of the vessel crew. Biologists are available to help 
work gear at the request of the deck supervisor. 

DATA COLLECTION 
Pot Condition and Substrate: 
When a pot is pulled, its condition and proper fishing status will be recorded using the “Crab 
Specimen Form” (Appendix B2). Any evidence that the pot was on its side, mesh had holes, errors 
in closing the pot, and the sediment type, if any, found on the pot will be noted (Table 4). Holes 
or other features that would allow small crabs to escape will be repaired before the pot is used 
again. The contents of each pot will be carefully emptied onto a sampling table. Commercially 
important bycatch species (Table 3) will be counted and numbers recorded on the “Crab Survey 
Specimen” form (Appendix B2), then returned to the sea. All captured Pycnopodia helianthoides 
will be measured in millimeters from tip of an arm to the tip of the arm directly across and recorded, 
and yelloweye rockfish (Sebastes ruberrimus) will be returned to the water via a deepwater release 
mechanism to 100 ft. All king, Tanner, and Dungeness crabs will be assessed for collection of 
biological information before being returned to the sea. 

Biological Information: 
The carapace width (CW) of Tanner and Dungeness crabs and the carapace length (CL) of all king 
crab will be measured with Vernier calipers to the nearest millimeter, using the standard biological 
measurement for that species (Figure 2). Shell condition of crabs will also be assessed (Table 2). 
All legal and pre-recruit sized Tanner crab will be measured and should be made priority above all 
other size/sex class and species.  
If there are pots with high numbers of crab, a maximum of approximately 100 crab (50 minimum 
for male crab) should be sampled. If there is high variability in clutch size, as many females as 
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possible will be sampled. The scientific lead on each leg will determine if and at what rate to sub-
sample using the following criteria: 

• subsampling can occur by species and sex at a rate not to exceed 1:15, preferably from 1:2–
1:5;  

• male Tanner crab should be sampled 1:1; 
• female Tanner crab will be sub-sampled first, please note that every effort must be made 

to separate juvenile females and mature females prior to subsampling, and to subsample 
individuals of similar sizes as this could affect analyses; 

• small male Tanner crab will be sub-sampled second.  
For each crab, abnormalities in the carapace will be noted (Table 5). As of 2023, leg condition will 
no longer be gathered. The presence of any parasites or diseases, such as black mat or bitter crab 
syndrome, will be noted (Table 6, Figure 4). 
For all female crabs, the percent clutch fullness will be estimated in 10% increments, and the 
development and condition of the eggs will be noted (Table 7).  
Chela heights of adult Tanner crab will be measured to monitor any changes in the size at 
functional maturity (point when mature males are “large clawed”). For each survey area, a total of 
150 male Tanner crab are randomly sampled until target numbers are achieved within each of 6 
size groups and measured for biological carapace width (to the nearest 1 mm) and right chela 
height, (also to the nearest 1 mm) using Vernier calipers (Jadamec et al. 1999; Table 8, Figure 3, 
Appendix B3).  
Individual crab weights, for use in the length-weight relationship for each area, were last measured 
in 2010 and will not be measured to increase sampling efficiency.  

DATA INTEGRITY 
Data will be recorded on standard data sheets (Appendix B2) and entered into the Zander database 
onboard the vessel by the biological survey staff. Once the data is entered, datasheets are marked 
with initials of the person entering the data (entered by: initials). The database is then re-checked 
against the datasheets for errors, preferably by a different biological staff, and datasheets are 
marked with initials of the person verifying the data (verified by: initials). This should be 
completed prior to disembarking from the vessel to ensure a time efficient analysis of the data. All 
data are housed in OceanAK, a relational database available via intranet to ADF&G researchers 
and managers statewide (subject area: Region 1–Invertebrates–Surveys–Crab). Raw datasheets are 
archived.  

LOST POT PROTOCOL  
If a pot is lost (buoy is not visible); a retrieval pot (with biotwine cut, escape rings opened, and 
tidbit removed) will be set next to the lost pot with a pot saver (an upside-down grappling hook 
that is attached to and slides onto the floating line) attached just above the bridle. Extra line should 
be placed on the retrieval pot, depending on depth, to allow the vessel to circle the lost pot a 
minimum of 4 times adequately. The line from the retrieval pot should be left in the block and tied 
off to a cleat until four rotations are complete before the retrieval pot is hauled. The skipper should 
make every attempt to keep the line at ninety degrees to the boat. This process should be repeated 
a second time if the pot is not retrieved on the first attempt if time allows. 
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VOLUNTEERS 
Occasionally, volunteers such as graduate students or National Parks Service employees join the 
crew for a portion of a fall crab survey leg. They typically help with gear work and/or sorting crab 
species once they have been briefed by both the boat and scientific crew. Prior to boarding the R/V 
Medeia, all volunteers must be approved by the crab group staff and complete the “Volunteer 
Agreement” form (Appendix B4). 

VESSEL 
The State of Alaska owned research vessel, R/V Medeia, is used to conduct the annual fall crab 
survey. This 110-foot vessel was built in 1982 of iron, steel, and alloy, and has a net capacity of 
246 tons. It currently resides at Harris Harbor in Juneau, Alaska. The vessel crew consists of 4 
positions: Boat Officer IV, Boat Officer III, Boat Officer II, and Boat Officer I. 

DATA ANALYSIS 
All data are entered in Zander and stored in OceanAK, ADF&G’s database. Data analyses are done 
using the most updated version of R1. After the completion of each survey area, the data from the 
survey area is uploaded and stored into OceanAK 

SURVEY CATCH PER UNIT OF EFFORT 
Data, including sex and size, is collected for all Tanner crab in each pot. Based on the sex and size 
designations, crab are classified into recruit classes. Males are classified based on size and shell 
conditions according to Table 2. Females are classified as either large and mature or small and 
immature based on both size and presence of physical maturity (Donaldson and Byersdorfer 2005). 
CPUE is summarized for each recruit class in each pot, with the goal of calculating a stratified 
weighted average CPUE for each survey area. Only pots that are classified as “normal” are 
included in this analysis. Abnormal pots are removed to prevent bias (refer to Table 4 for abnormal 
pots designations). 
Due to the stratified design of the survey, the average CPUE for each area must be calculated as a 
weighted average, including both the number of pots sampled in each strata and the area of each 
strata. Catch in each pot is weighted by a multiplier of the area of each strata divided by the number 
of pots sampled in that strata in the current year. Once each pot’s catch is weighted, an average 
CPUE for each recruit class is computed for each survey area. Weighting the CPUE is essential 
due to the stratified design of the survey and differential sample size in each stratum.   

STOCK HEALTH DETERMINATION 
Historically, the weighted CPUEs and survey data calculated for each recruit class have been used 
to help determine the overall stock health for each survey area. This is accomplished by comparing 
the current year’s data to long-term and short-term indicators (Siddon et al. 2009). This method 
for evaluating stock health is repeatable and objective; additionally, it has been used for other crab 
and invertebrate species in Southeast Alaska. The following metrics are examined to evaluate stock 
health: mature female clutch fullness and catch rate, pre-recruit CPUE, recruit CPUE, and post-
recruit CPUE.  

 
1 The R project for statistical computing. Version 4.5.0. Vienna, Austria. https://www.R-project.org/ (accessed April 14, 2025). 

https://www.r-project.org/
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All the metrics, except mature female clutch fullness, are calculated using weighted CPUE from 
the survey. For the long-term trends, the current year’s metric is compared, using a t-test, to the 
long-term mean calculated from baseline years (1997–2006). This specific time-period, from 
1997–2006, was established in 2007 as the first 10 years of survey data. In the future, this year's 
range should be evaluated to ensure that it encompasses a range of population levels. If the current 
year is significantly above the long-term mean, it is scored +1; if it is not different from the mean, 
it is scored 0; and if it is significantly lower than the mean, it is scored -1. The short-term trends 
are examined by performing a linear regression on the last four years of data for each metric. The 
significance of these regressions is then scored similarly to the long-term trends, with a positive 
trend having a score of 0.25, no trend having a score of 0, and a negative trend having a score of -
0.25. The area scores sums all the long-term and short-term scores for each metric into one score 
for each area. Scores less -3.25 are considered poor, between -3.25 and -1.26 below average, 
between -1.25 and 1.25 moderate, between 1.26 and 3.25 above average, and above 3.25 healthy.  
Mature female clutch fullness is evaluated differently by calculating the mean proportion of mature 
females in each pot with a clutch fullness of < 25% (i.e. very small clutches).  The level allows for 
biologist error in assessing clutch fullness to the nearest 10 % on the survey, low clutches (<25%) 
are usually noticeably low.   

STOCK ASSESSMENT 
Tanner crab biomass, both mature and legal, is estimated using a CSA model that relies on inputs 
from both the survey and the fishery (in years when the fishery was open).   

Model inputs 
Inputs from the survey data include: weighted CPUE of pre-recruit, recruit, and post-recruits by 
survey area, mid-date for the survey, and average weight (using the established length-weight 
relationships) of pre-recruit, recruit, and post-recruits. The mid-date for the survey is the middle 
date for the pots set in each survey area.  If the area is surveyed, an even number of days the date 
used would be the first day of the second half of the survey for that area. For example, if an area 
were surveyed for 4 days, the date used would be the third day of the survey. 
The average weight of male crab in each survey year is calculated from the length composition 
collected on the survey using a survey area specific length-weight relationship. These relationships 
were established from survey data (1997–2007). A summary of the relationships for each area is 
provided in Table 9.   
Inputs from the fishery include catch in numbers and the mid-date of the fishery, both of which 
are obtained from the commercial fish ticket database. The mid-date for the fishery is computed 
as the sum of the days in the season, the ratio of the catch for that day, divided by the total catch 
for the area and season (Clark et al. 2003).   

The model  
A CSA model is used to estimate mature and legal abundance of Tanner crab for each of the 
surveyed areas. This analysis type was initially developed by Collie and Sissenwine (1983) and 
adapted for crab abundance estimation in the 1990s (Kruse and Collie 1991; Zheng et al. 1997; 
Collie and Kruse 1998). Starting in 2007, a three-stage model was used to estimate abundance of 
Tanner crab in Southeast Alaska, using pre-recruits, recruits, and post-recruits (Zheng et al. 2007).  
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This type of model estimates the abundance of a population by comparing the changes in survey 
catches to the number of crabs removed by the commercial and personal use effort. In a three-stage 
model pre-recruits are estimated every year and recruits are related to the number of pre-recruits 
that survive and molt to become recruits (Eq. 1). Post-recruits are estimated from the recruits and 
post-recruits in the previous year and the fishery removals that occur between the survey years 
(Eq. 2). Errors are associated with both survey and fishery catch and are assumed to be log-
normally distributed (Eq. 3). A constant instantaneous natural mortality of 0.30 is used; this 
translates to an annual natural mortality of 26% (Zheng at al. 2007).  
Equations depicted below are modified from those already published in documents pertaining to 
CSA models in Southeast Alaska (Woodby 1994; Clark et al. 2003; Zheng et al. 2007). 
These are the two processes described in the three-stage CSA model:  

                                                                   𝑅𝑅𝑦𝑦𝑦𝑦+1 = 𝜇𝜇𝐴𝐴𝑦𝑦𝑦𝑦                                      (1) 

                                              𝑃𝑃𝑦𝑦𝑦𝑦+1 = �𝑅𝑅𝑦𝑦𝑦𝑦 + 𝑃𝑃𝑦𝑦𝑦𝑦�𝑒𝑒𝑀𝑀𝑀𝑀𝑦𝑦𝑦𝑦 − 𝑞𝑞𝐶𝐶𝑦𝑦𝑦𝑦𝑒𝑒𝑀𝑀𝑀𝑀𝑦𝑦𝑦𝑦                                (2) 

Where:  
Ryr+1 = relative abundance of recruit crab in year +1 
Ayr = relative abundance of pre-recruit crab in year yr 
µ = proportional constant, a function of the relative catchability of pre-recruit and recruit crab, 
along with the survival and probability of molting from pre-recruit to recruit crab 
Pyr+1 = relative abundance of post-recruit crab in year +1 
Cyr = total harvest (in number of crabs) in year yr 
tyr = time interval between surveys (in years) 
lyr = time lag between the midpoint of the fishery in year yr and the survey in year yr +1  
q = catchability coefficient relating relative abundance measured as catch per pot in the survey to 
absolute abundance of crab in the area 
M = instantaneous natural mortality coefficient 
The observed catches in the survey are the relative abundances with lognormally distributed 
measurement error: 

                                                                    𝐴̃𝐴𝑦𝑦𝑦𝑦 = 𝐴𝐴𝑦𝑦𝑦𝑦𝑒𝑒𝜏𝜏𝑦𝑦𝑦𝑦                                                  (3) 

𝑅𝑅�𝑦𝑦𝑦𝑦 = 𝑅𝑅𝑦𝑦𝑦𝑦𝑒𝑒𝜐𝜐𝑦𝑦𝑦𝑦 

𝑃𝑃�𝑦𝑦𝑦𝑦 = 𝑃𝑃𝑦𝑦𝑦𝑦𝑒𝑒𝜔𝜔𝑦𝑦𝑦𝑦 

Where:  

𝜏𝜏𝑦𝑦𝑦𝑦 , 𝜐𝜐𝑦𝑦𝑦𝑦,and 𝜔𝜔𝑦𝑦𝑦𝑦 = normal deviates 

The values of Ayr, Ryr, and Pyr are estimated by minimizing the squared deviation of the log of the 
estimated values and observed values. The squared deviations are not weighted to take into account 
differences in survey methods throughout the years because survey methods have remained 
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consistent over the time series. Minimizing the sum of the squared deviations was performed using 
the optim function in the most recent version of R. 

Model output 
The CSA model computes an estimated relative index value for each of the three recruit classes 
(pre-recruit, recruit, and post-recruit), which is then scaled (using q which is estimated in the 
model) to a number of male crab for each recruit class. The number of crab in each recruit class is 
converted to a biomass (lb) using the average weight of all three recruit classes from the survey 
(using the length-weight relationship established for each area). For each survey area the biomass 
of both legal (recruits and post-recruits) and mature (all three male recruit classes) is reported. 
These are summarized annually in the Southeast Alaska Tanner crab stock assessment 
memorandum prepared by the biometrics group.   

REGIONAL ESTIMATION  
Tanner crab are managed regionally in Southeast Alaska, therefore the estimate of biomass from 
all surveyed areas combined is used to produce a regional estimate of Tanner crab by expanding 
the estimate to the non-surveyed areas based on historic catch data. The period of 1980–2000 is 
used to establish the proportion of catch in survey (66%) vs. non-surveyed areas (34%). Total 
estimated biomass is reported annually in the Southeast Alaska Tanner crab stock assessment 
memorandum, as well as being used to establish season length in the commercial fishery. 

STAFF AND RESPONSIBILITIES 
• Adam Messmer, Fishery Biologist III (Lead Crab Biologist/Scientific Crew Lead) 
• Zane Chapman, Fishery Biologist II (Scientific Crew Lead) 
• Tessa Bergmann, Fishery Biologist I (Scientific Crew Lead) 
• Joe Stratman, Fishery Biologist III (Scientific Crew Lead) 
• Katie Palof, Fishery Scientist I (Biometric Review) 
• Caitlin Stern, Biometrician II (Biometric Review) 
• Alex Reich, Biometrician II (Biometric Review) 
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Logistics and Field Studies 
Adam Messmer has primary responsibilities associated with logistics and field studies. One of 
the 3 fishery biologists listed will be the principle investigator of each leg of the survey, the 
specific person responsible will be listed annually in Appendix D1. 
Database Integrity 
Zane Chapman has primary responsibilities associated with data entry and database integrity 
queries. Zane Chapman will be assisted by field crews. 
Data Analysis 
Alex Reich will have the primary responsibility for catch-survey modeling and matrix 
analyses. 
Stock Assessment/Management Report 
An annual regional information report (RIR) will be published, with Alex Reich having 
primary responsibilities associated with the analysis of survey results and assessment, and 
Adam Messmer having primary responsibilities associated with the commercial fishery and 
personal use fishery management recommendations and resulting decisions. 
Calendar of Activities 

Dates Activity Personnel 

May/June Define pot survey locations in ArcGIS FB II and FB III 
September Regional Operation Planning FB II and  
September Purchase, prepare, and stage survey gear FB II and FB III 
September/October  Conduct two legs of at-sea surveys All 

November 
Compile and edit fall crab pot survey data and submit to 
biometrics for stock assessment report 

Biometrician, FB II, and 
FB III 

November Stock assessment analysis of catch survey data Biometrician 

December Finalize stock assessment and management memo All 

December Management announces the potential season and start date Management staff 
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Table 1.–Southeast Alaska fall crab pot survey location codes. 

Survey area Location code 
Icy Strait 2 
Holkham Bay 8 
Glacier Bay 3 
Thomas Bay 5 

 
Table 2.–Southeast Alaska Tanner crab shell age criteria. 

Shell 
condition Shell age Description 

1, soft 0–2 weeks The exoskeleton is soft, flaccid, similar in texture to skin, and loses shape out 
of water. No scratches, abrasions, or epibionts are present. 

2, light 2–8 weeks 

Carapace and chela are firm, but thin and flexible and can be easily indented 
with slight thumb pressure. Legs are easily compressed when pinched. Colors 
are bright. Iridescence is common. Abdominal flap may appear translucent. 
Spines, chela tips, chela teeth, and dactyls are sharp. No scratches, abrasions, 
or epibionts are present.  

3, new 2–12 months 

Carapace and chela are hard and will crack when pressure is applied. Legs are 
not easily compressed when pinched and will break if bent. Colors are bright 
and iridescence (especially on the chelas) is often visible. Ventral surfaces can 
be any variation of white or pink and are not translucent. Spines, chela teeth, 
and dactyls are sharp. Abdomen and legs have little or no scratches and 
abrasions. Slight fouling may be present, including; leech egg cases, small 
barnacles, and encrusting bryozoans. Adult females rarely have grasping marks 
on the meri. 

4, old 13–24 months 

Skip molts. Colors are dull, but there may be some visible iridescence on the 
chelas. Ventral surfaces typically appear yellow to brown. Spines, chela tips, 
chela teeth, and dactyls show some wear and appear dull. Abdomen and legs 
have few to numerous scratches and abrasions, which are slightly darker than 
the shell. The meat content is full. Some fouling may be present, including but 
not limited to; leech egg cases, barnacles, bryozoans, and tubeworm casings. 
Females mated a second time will can show grasping marks on the meri. 

5, very old >24 months 

Color is dull and dark on dorsal surface. Ventral surface typically appears 
yellow to brown with darker areas. Spines, chela tips, chela teeth, and dactyls 
are heavily worn. Legs are commonly damaged or missing. Abdomen and legs 
have numerous scratches and abrasions, which are typically darker than the 
shell. Moderate to heavy fouling is common, including but not limited to; leech 
egg cases, large barnacles, bryozoans, hydroids, anemones, and tubeworm 
casings. Adult females will have abdomens that appear very worn and scuffed. 
Females that have been mated more than two times can have multiple grasping 
marks on the merus. 

Note: Table adapted from Donaldson and Byersdorfer (2005). 
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Table 3.–Southeast Alaska crab pot survey bycatch species code list. 

Species code Species  Species code Species 
110 Pacific (gray) cod  850 Weathervane scallop 
127 Yellowfin sole  892 Red sea urchin 
129 Starry flounder  894 California sea cucumber 
130 Lingcod  910 Dungeness crab 
145 Yelloweye rockfish  921 Red king crab 
147 Quillback rockfish  922 Blue king crab 
200 Halibut  923 Golden king crab 
270 Walleye pollock  931 Tanner crab 
710 Sablefish (blackcod)  964 Coonstripe shrimp 
870 Octopus  965 Spot shrimp 
363 Neptunea species  381 Pycnopodia 
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Table 4.–Southeast Alaska crab survey codes for pots to describe debris, substrate, pot condition, type, 
dimensions, escape device, and bait. 

Code Debris Substrate Pot condition Pot type Pot dimensions Escape device Bait 
0 a Unknown a a a a a 

1 
Large 

brown kelp Mud Normal Pyramid 4’ diameter 
None/closed 

rings No bait 

2 Mussels Mud/gravel Not baited Cone 
5–5’11” 
diameter 

king (4, 6 ¼ 
inch rings) 

Jar & 
hanging 

3 Shells Mud/clay Lost Square 
6–6’11” 
diameter 

king (9 inch 
stretch mesh) Jar only 

4 
Woody 

debris Mud/shell Door open Dungeness 
7–7’11” 
diameter 

Tanner (4, 4 ¾ 
inch rings) 

hanging 
only 

5 Hair kelp Mud/soft 
Broken 

webbing a 7x7 
Tanner (7 inch 

stretch mesh) a 

6 Barnacles Mud/hard Upside down a 8x8 
Dungeness (2, 4 

⅜ inch rings) a 

7 Sponges Clay 
Collapsed 

tunnel a 9x9 a a 

8 a Sand 
Not on 
bottom a a a a 

9 a Gravel 
Pot 

open/broken a a a a 

10 a Boulder 
Lost pot 
contents a a a a 

11 a Cobble a a a a a 
12 a Rock a a a a a 
13 a Hard a a a a a 
14 a Soft a a a a a 
15 a Shell a a a a a 
16 a Coral a a a a a 
17 a Mixed a a a a a 
18 a Silt a a a a a 
19 a Barnacle a a a a a 
20 a Mussels a a a a a 

a code not used 
 

Table 5.–Leg loss codes used for the Tanner crab survey. 

 

  

Code Criteria 
4 Carapace damage 
5 Combination of conditions 
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Table 6.–Southeast Alaska crab survey parasite condition codes. 

Code Parasite 
1 None 
2 Briarosaccus, single scar 
3 Briarosaccus, double scar 
4 Briarosaccus, single externa 
5 Briarosaccus, double externa 
6 Bitter crab, Hematodinium 
7 Microsporidian 
8 Nemertean worms 

 
Table 7.–Southeast Alaska crab survey female reproductive condition codes. 

Code Clutch condition Egg development 
1 Normal Eyed eggs 
2 <20% dead eggs in the clutch Uneyed eggs 
3 >20% dead eggs in the clutch No eggs 
4 Barren with silky setae NA 
5 Barren with matted setae and empty egg cases NA 

Note: codes come from Donaldson and Byersdorfer 2005. NA indicates not applicable. 
 

Table 8.–Southeast Alaska crab survey sample goals by carapace width range category for male Tanner 
crab chela height measurements. 

Carapace width Sample goal 
<106 25 
106–114 25 
115–122 25 
123–131 25 
132–152 25 
>152 25 

 
Table 9.–Southeast Alaska Tanner crab survey length-weight conversion formula coefficients.  

Survey Area Intercept Slope 
Glacier Bay -9.48 3.30 
Icy Strait -9.48 3.29 
Thomas Bay -9.67 3.32 
Holkham Bay -9.73 3.34 

Note: formula is weight (lb) = exp[Intercept + slope*ln(carapace length)] *(2.2/1000). 
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Figure 1.–Southeast Alaska summer and fall crab survey areas. 
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Figure 2.–Crab carapace measurements, left: measuring carapace length, all king crab and right: 

measuring carapace width applicable to both Tanner (pictured) and Dungeness crab. 

 
Figure 3.–Chela height measurement location for male Tanner crab, right claw. 
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Figure 4.–Briarosaccus externa and externa scars on red and golden king crab. 
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APPENDIX A: HOBO WATER TEMPERATURE DATA 

LOGGER INSTRUCTIONS 
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Appendix A1.–HOBO Water Temperature Data Logger Instructions. 

1) One logger for each pot (~20–28) will be deployed on the first day of setting per trip (Appendix 
A1). 

2) Activate logger using optical USB base station attached to computer (Appendix A2).  
a. Name will be a unique number that matches the buoy number of the pot in which logger 

will be attached.  
b. Time interval: 1-hour. 
c. Check that red ‘OK’ light is flashing before activating the next tidbit. 

3) One temperature logger will be placed on each deployed pot with a cable tie near the tunnel of the 
pot, and with the buoy number facing out. 

4) Write in comments column of skipper form, ‘Tidbit # X’ (where X is the number of the tidbit). 
This should be done by the crewmember in the wheelhouse documenting coordinates and 
associated data during the setting of pots each day. 

5) Temperature loggers will be downloaded at the end of each leg, saved in Excel, and transferred to 
a file on the desktop of the R/V Medeia computer. 

6) Files will be saved on a memory stick (or other media) aboard vessel; leave backup copy aboard 
R/V Medeia computer. 

7) Files will be saved to: CF…Shellfish\Temperature\current year. 
8) Detailed Data Download Instructions: 

a. Files will be saved using the .dtf format and subsequently exported to a .txt format.  
b. Export file:  

i. Plug tidbit into the docking device 
ii. Device → Readout → Stop. 

iii. Create a custom folder for the survey 
iv. File → Export Table Data → Export. 
v. Date format: Month/Day/Year  

vi. Date/Time Separator: Tab  
vii. Time Format: Hr:Min:Sec  

viii. Data Separator: Tab  
ix. Highlight “Temperature (*C)” only. 

c. Save file as the tidbit number to the custom survey folder created in b: 
i. For example, Tidbit #8 should be saved as 8.txt 

d. Open .txt file in Excel:  
i. File → Open (Do not double click the text file to open).  

ii. Select “Finish” on the import menu. 
e. To be done post survey: 

i. Within the Zander application click on “import Temperature Data”  
ii. Click "Edit Temperature Data”  

iii. Set the Discard Temperatures within X minutes to 30 minutes  
iv. Import all the excel files from the entire leg by choosing all the excel files, the 

app will produce an average temperature for each pot at each location    
v. Look through the results and check the temperature variance for each pot 

location, if greater than 2 check the raw data for any outliers  
vi. If outlier occurs, check the raw data for the correct pot data or adjust the cutoff to 

remove the outlier   
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Appendix A2.–HOBO water temperature data logger device that will be attached to each deployed crab 
pot. 
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Appendix A3.–HOBO optic USB base station attached to computer; used to activate loggers. 
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APPENDIX B: SURVEY DATA FORMS 
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Appendix B1.–Crab Pot Set Form. 
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Appendix B2.–Crab Survey Specimen and Incidental Species Form. 
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Appendix B3.–Tanner Crab Chela Height Size Category Tally Sheet. 

Male Tanner crab chela heights: This tally sheet can be printed used to track the number of male 
Tanner crab of each size category to be sampled in the field. Throughout the day, collect chela 
height for carapace length categories listed below: 

 
Carapace 

size <106 106-114 115-122 123-131 132-152 >152 

Sample 
number 25 25 25 25 25 25 

       

       

       

 
 

Carapace 
size <106 106-114 115-122 123-131 132-152 >152 

Sample 
number 25 25 25 25 25 25 
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Appendix B4.–Volunteer Agreement Form. 

 
 

-continued-
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Appendix B4.–Page 2 of 2. 
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Appendix B5.–Instructions for transferring pot coordinate data to R/V Medeia navigational computers. 

R/V MEDEIA COMPUTER 
• Open “Site 200X.txt file. 
• Open “Medeia template” file. 
• Cut and paste lat/long into appropriate columns from text file to template file. 

o The lat/long column order is reversed in the template file. Make sure “latitude” is before “longitude” 
in the template file or Maptech will not recognize it. 

• Cut and paste “strata” into “Notes/Strata” column. 
• Enter name. This entry must start with 48sgw for Maptech to recognize it.  
• Individually name each pot location an (e.g., 48sgwHolkham 1, 48sgwHolkham 2, 48sgwHolkham 3,….). 
• Save as “marks32.txt” (This is the only file name Maptech recognizes). 
 
MAPTECH 
• Open Maptech (on Medeia wheelhouse computer).  
• File> Import from File and browse for the folder where the “marks32” file is located. 
• Select all marks for the site and import. It will give the number of marks imported successfully. 
• Check the chart to make sure pot locations have in fact shown up in the appropriate spot. 
• Repeat procedure for each site text file.  
• Overwrite the “marks32” file each time. 
• A detailed explanation of the Maptech import/export format in R:/>…… /Tanner pot location maps /Transfer to 

Medeia> Maptech export format explanation. 

 
MAXSEA 

• The skipper of the R/V Medeia will import pot locations from Maptech to Maxsea once they have created routes 
between pots.  

 



 

 30 
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APPENDIX C: INSTRUCTIONS FOR TRANSFERRING POT 
COORDINATE DATA TO R/V MEDEIA NAVIGATIONAL 

COMPUTERS 
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Appendix C1.-Instructions for transferring pot coordinate data to R/V Medeia navigational computers. 

R/V MEDEIA COMPUTER 
• Open “Site 200X.txt file. 
• Open “Medeia template” file. 
• Cut and paste lat/long into appropriate columns from text file to template file. 

o The lat/long column order is reversed in the template file. Make sure “latitude” is before 
“longitude” in the template file or Maptech will not recognize it. 

• Cut and paste “strata” into “Notes/Strata” column. 
• Enter name. This entry must start with 48sgw for Maptech to recognize it.  
• Individually name each pot location an (e.g., 48sgwHolkham 1, 48sgwHolkham 2, 48sgwHolkham 3,….). 
• Save as “marks32.txt” (This is the only file name Maptech recognizes). 
 

MAPTECH 
• Open Maptech (on Medeia wheelhouse computer).  
• File> Import from File and browse for the folder where the “marks32” file is located. 
• Select all marks for the site and import. It will give the number of marks imported successfully. 
• Check the chart to make sure pot locations have in fact shown up in the appropriate spot. 
• Repeat procedure for each site text file.  
• Overwrite the “marks32” file each time. 
• A detailed explanation of the Maptech import/export format in R:/>…… /Tanner pot location maps /Transfer to 

Medeia> Maptech export format explanation. 

 
MAXSEA 

• Open Maxsea  
• File> Import from File and browse for the folder where the “marks32” file is located 
• Select import files 
• Once locations are imported click the tab on the top of the screen to view marks. 

  



 

 33 

 

 
APPENDIX D: 2024 SURVEY INFORMATION 
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Appendix D1.–2024 Fall crab survey schedule. 

The fall crab survey is composed of two legs conducted on the R/V Medeia. If any staffing 
changes occur mid-trip, due to illness or otherwise, the project leaders (Adam Messmer, Tessa 
Bergmann, and Zane Chapman) must be notified immediately. 
  
R/V Medeia Vessel Crew 

Position Title Crew 
Captain Boat Officer IV Cedar Stark 

First Mate Boat Officer III Jacob Eberhardt 
Engineer Boat Officer II Rick Gotwald 

Cook/Mate Boat Officer I Katy Hamilton 
 
Leg 1:  Holkham and Thomas Bay (8 days) 
Dates:  October 7–14, 2024 
Vessel: R/V Medeia 
Biologists: Adam Messmer (lead), Zane Chapman, Tessa Bergmann, and Alex Reich 
 

Date Day Location Morning task Afternoon task # of Pots 
10/7 Monday Holkham Bay Travel to Holkham Bay Set pots Holkham Bay 26 
10/8 Tuesday Holkham Bay Pull pots Set Pots Holkham Bay 26 
10/9 Wednesday Holkham Bay Pull pots Set Pots Holkham Bay 26 

10/10 Thursday Holkham Bay Pull pots Run to Thomas Bay  
10/11 Friday Thomas Bay Travel to Thomas Bay Set Pots Thomas Bay 26 
10/12 Saturday Thomas Bay Pull pots Set Pots Thomas Bay 26 
10/13 Sunday Thomas Bay Pull pots Travel to Juneau.  
10/14 Monday Thomas Bay Travel to Juneau Travel to Juneau  

 
Leg 2:             Glacier Bay and Icy Strait (7 days) 
Dates:  October 21–27, 2024 
Vessel: R/V Medeia 
Biologists:  Zane Chapman (lead), Joe Stratman, and Daison Weedop 

 

Date Day Location Morning Task Afternoon Task # of Pots 
10/21 Monday  Travel to Glacier Bay   
10/22 Tuesday Glacier Bay Travel to Glacier Bay Set pots in Glacier Bay 26 
10/23 Wednesday Glacier Bay Pull pots Set pots in Glacier Bay 26 
10/24 Thursday Glacier Bay Pull pots Set pots in Icy Strait 26 
10/25 Friday Icy Strait Pull pots Set pots in Icy Strait 26 
10/26 Saturday Icy Strait Pull pots Travel to Juneau  
10/27 Sunday  Travel to Juneau   
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APPENDIX E: 2024 HOLKHAM BAY SURVEY AREA POT 

LOCATIONS 
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Appendix E1.–2024 Holkham Bay survey area fall crab pot locations.  
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Appendix E2.–2024 fall pot location coordinates for Holkham Bay survey area with strata and status. 

Strata Latitude Longitude Status 
1 57.74025 -133.655 Extra 
1 57.73680 -133.514 Extra 
1 57.73621 -133.627 Extra 
1 57.73905 -133.616 Good 
1 57.80055 -133.583 Good 
1 57.73373 -133.552 Good 
2 57.82977 -133.600 Extra 
2 57.83667 -133.602 Extra 
2 57.72723 -133.573 Extra 
2 57.73715 -133.609 Good 
2 57.73603 -133.496 Good 
2 57.71497 -133.550 Good 
2 57.80739 -133.593 Good 
2 57.83306 -133.593 Good 
2 57.78875 -133.581 Good 
3 57.73099 -133.564 Good 
2 57.83967 -133.595 Good 
2 57.68359 -133.491 Good 
2 57.81350 -133.602 Good 
3 57.80739 -133.600 Extra 
3 57.81714 -133.606 Extra 
3 57.81776 -133.612 Extra 
3 57.84664 -133.583 Good 
3 57.72348 -133.617 Good 
3 57.69874 -133.533 Good 
3 57.68879 -133.493 Good 
3 57.70051 -133.533 Good 
3 57.78511 -133.577 Good 
3 57.71803 -133.540 Good 
3 57.79064 -133.575 Good 
3 57.73033 -133.496 Good 
3 57.71506 -133.542 Good 
3 57.72362 -133.634 Good 
3 57.71231 -133.541 Good 
3 57.72070 -133.567 Good 
3 57.84887 -133.621 Good 
3 57.72120 -133.501 Good 
3 57.72398 -133.528 Good 

-continued- 
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Appendix E2.–Page 2 of 3. 

Strata Latitude Longitude Status 
3 57.82048 -133.615 Good 
3 57.78661 -133.572 Good 
3 57.70963 -133.541 Good 
3 57.81116 -133.580 Good 
3 57.81633 -133.589 Good 
3 57.82022 -133.583 Good 
3 57.72390 -133.523 Good 
3 57.82955 -133.615 Good 
3 57.82602 -133.597 Good 
3 57.84449 -133.583 Good 
3 57.79252 -133.573 Good 
3 57.81864 -133.594 Good 
3 57.72626 -133.487 Good 
3 57.80541 -133.605 Good 
3 57.72369 -133.508 Good 
3 57.71867 -133.492 Good 
3 57.71274 -133.534 Good 
3 57.82244 -133.612 Good 
3 57.72006 -133.527 Good 
3 57.69268 -133.487 Good 
3 57.81575 -133.621 Good 
3 57.72683 -133.492 Good 
3 57.72234 -133.564 Good 
3 57.72184 -133.520 Good 
4 57.69468 -133.501 Extra 
4 57.85117 -133.617 Extra 
4 57.71455 -133.525 Extra 
4 57.71887 -133.606 Good 
4 57.69276 -133.501 Good 
4 57.69168 -133.509 Good 
4 57.71706 -133.592 Good 
4 57.82432 -133.590 Good 
4 57.71471 -133.504 Good 
4 57.70523 -133.527 Good 
4 57.71865 -133.510 Good 
4 57.70671 -133.506 Good 
4 57.69644 -133.518 Good 
4 57.70359 -133.503 Good 
4 57.72034 -133.628 Good 
4 57.69417 -133.493 Good 

-continued-  
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Appendix E2.–Page 3 of 3. 

Strata Latitude Longitude Status 
4 57.70055 -133.530 Good 
4 57.72197 -133.587 Good 
4 57.85773 -133.632 Good 
4 57.71121 -133.498 Good 
4 57.71000 -133.526 Good 
5 57.69695 -133.498 Good 
5 57.72166 -133.612 Good 
5 57.69743 -133.508 Good 
5 57.81433 -133.577 Good 
5 57.71538 -133.632 Extra 
5 57.71646 -133.625 Extra 
5 57.71693 -133.633 Extra 
5 57.71528 -133.628 Good 
5 57.71275 -133.631 Good 
5 57.71772 -133.628 Good 
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APPENDIX F: 2024 THOMAS BAY SURVEY AREA POT 

LOCATIONS  
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Appendix F1.–2024 Thomas Bay survey area fall crab pot locations. 
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Appendix F2.–2024 fall pot location coordinates for Thomas Bay survey area with strata and status. 

Strata Latitude Longitude Status 
1 57.0237 -132.955 Extra 
1 57.0218 -132.977 Extra 
1 57.0070 -132.957 Extra 
1 57.0014 -132.952 Good 
1 57.0076 -132.966 Good 
1 57.0053 -132.960 Good 
2 56.9993 -132.927 Extra 
2 57.0042 -132.948 Extra 
2 57.0214 -132.958 Extra 
2 57.0333 -132.938 Good 
2 57.0083 -132.951 Good 
2 57.0194 -132.908 Good 
2 57.0119 -132.969 Good 
2 57.0091 -132.938 Good 
2 57.0129 -132.932 Good 
2 57.0252 -132.981 Good 
2 57.0102 -132.934 Good 
2 57.0261 -132.936 Good 
2 57.0114 -132.948 Good 
2 57.0225 -132.966 Good 
2 57.0093 -132.972 Good 
3 57.0230 -132.886 Extra 
3 57.0311 -132.966 Extra 
3 57.0085 -132.901 Extra 
3 57.0365 -132.937 Good 
3 57.0187 -132.950 Good 
3 57.0431 -132.952 Good 
3 57.0152 -132.967 Good 
3 57.0067 -132.869 Good 
3 57.0409 -132.959 Good 
3 57.0314 -132.948 Good 
3 56.9993 -132.895 Good 
3 57.0118 -132.956 Good 
3 57.0275 -132.966 Good 
3 57.0465 -132.964 Good 
3 57.0103 -132.898 Good 
3 57.0316 -132.952 Good 
3 57.0166 -132.958 Good 
3 57.0129 -132.902 Good 

-continued-  
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Appendix F2.–Page 2 of 2. 

Strata Latitude Longitude Status 
4 57.00233 -132.931 Extra 
4 57.01859 -132.902 Extra 
4 57.01046 -132.865 Extra 
4 57.00113 -132.888 Good 
4 57.01483 -132.904 Good 
4 57.00393 -132.882 Good 
4 56.99846 -132.910 Good 
4 57.00717 -132.883 Good 
4 57.02353 -132.898 Good 
4 57.00587 -132.881 Good 
4 57.01479 -132.862 Good 
4 57.00186 -132.907 Good 
4 57.00143 -132.912 Good 
4 57.01857 -132.870 Good 
4 57.02182 -132.874 Good 
4 57.01288 -132.866 Good 
4 57.00143 -132.894 Good 
4 57.01058 -132.888 Good 
4 57.01430 -132.889 Good 
4 57.02116 -132.879 Good 
5 57.01870 -132.897 Extra 
5 57.01630 -132.895 Extra 
5 57.00220 -132.903 Extra 
5 57.00590 -132.890 Good 
5 57.00370 -132.899 Good 
5 57.00340 -132.891 Good 
5 57.01390 -132.895 Good 
5 57.00540 -132.895 Good 
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APPENDIX G: 2024 GLACIER BAY SURVEY AREA POT 

LOCATIONS 
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Appendix G1.–2024 Glacier Bay survey area fall crab pot locations. 
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Appendix G2.–2024 Fall pot location coordinates for Glacier Bay survey area with strata and status. 

Strata Latitude Longitude Status 
1 58.64111 -136.148 Extra 
1 58.66951 -136.207 Extra 
1 58.62413 -136.158 Extra 
1 58.63519 -136.136 Good 
1 58.62774 -136.147 Good 
1 58.68810 -136.156 Good 
2 58.69869 -136.195 Extra 
2 58.59504 -136.087 Extra 
2 58.66646 -136.160 Extra 
2 58.70301 -136.153 Good 
2 58.62622 -136.171 Good 
2 58.68887 -136.192 Good 
2 58.63578 -136.157 Good 
2 58.64087 -136.038 Good 
3 58.67379 -136.146 Extra 
3 58.63894 -136.120 Extra 
3 58.69416 -136.026 Extra 
3 58.67655 -136.176 Good 
3 58.65957 -136.036 Good 
3 58.67702 -136.024 Good 
3 58.63408 -136.118 Good 
3 58.69875 -136.042 Good 
3 58.68390 -136.058 Good 
3 58.70089 -136.184 Good 
3 58.62990 -136.037 Good 
3 58.70898 -136.185 Good 
3 58.70871 -136.047 Good 
3 58.61805 -136.012 Good 
3 58.62866 -135.989 Good 
3 58.61001 -136.173 Good 
3 58.65530 -136.021 Good 
3 58.70479 -136.041 Good 
3 58.60966 -135.936 Good 
3 58.66674 -136.083 Good 
3 58.70570 -136.027 Good 
3 58.71754 -136.160 Good 
3 58.70213 -136.034 Good 
3 58.71053 -136.148 Good 

-continued- 
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Appendix G2.–Page 2 of 2. 

Strata Latitude Longitude Status 
3 58.70991 -136.065 Good 
3 58.65009 -136.044 Good 
3 58.61757 -136.083 Extra 
4 58.63956 -136.063 Extra 
4 58.60804 -136.189 Extra 
4 58.69711 -136.068 Good 
4 58.65483 -136.116 Good 
4 58.71174 -136.137 Good 
4 58.61824 -136.064 Good 
4 58.70093 -136.077 Good 
4 58.68851 -136.045 Good 
4 58.63471 -136.054 Good 
4 58.69851 -136.057 Good 
4 58.70903 -136.137 Good 
4 58.61333 -136.095 Good 
4 58.70564 -136.116 Good 
4 58.71702 -136.138 Good 
4 58.65520 -136.077 Good 
4 58.63981 -136.100 Good 
4 58.65045 -136.104 Good 
5 58.66397 -136.108 Good 
5 58.63151 -136.064 Extra 
5 58.62457 -136.195 Extra 
5 58.63118 -136.079 Extra 
5 58.62513 -136.076 Good 
5 58.61470 -136.048 Good 
5 58.62610 -136.047 Good 
5 58.62315 -136.049 Good 
5 58.62407 -136.205 Good 
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APPENDIX H: 2024 ICY STRAIT SURVEY AREA POT 

LOCATIONS  
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Appendix H1.–2024 Icy Strait survey area fall crab pot locations. 
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Appendix H2.–2024 fall pot location coordinates for Icy Strait survey area with strata and status. 

Strata Latitude Longitude Status 
1 58.36341 -135.742 Extra 
1 58.35335 -135.771 Extra 
1 58.34448 -135.712 Extra 
1 58.34941 -135.779 Good 
1 58.30748 -135.680 Good 
1 58.35036 -135.733 Good 
2 58.31733 -135.702 Extra 
2 58.36119 -135.754 Extra 
2 58.31390 -135.696 Extra 
2 58.35218 -135.759 Good 
2 58.35898 -135.754 Good 
2 58.35694 -135.751 Good 
2 58.30633 -135.692 Good 
2 58.36428 -135.748 Good 
2 58.36222 -135.746 Good 
2 58.31733 -135.702 Extra 
2 58.36119 -135.754 Extra 
3 58.36016 -135.748 Extra 
3 58.33404 -135.785 Extra 
3 58.34841 -135.741 Extra 
3 58.33459 -135.800 Good 
3 58.33644 -135.720 Good 
3 58.34223 -135.747 Good 
3 58.30192 -135.703 Good 
3 58.33902 -135.778 Good 
4 58.33278 -135.769 Extra 
4 58.31815 -135.714 Extra 
4 58.33659 -135.739 Extra 
4 58.33105 -135.788 Good 
4 58.33297 -135.742 Good 
4 58.31463 -135.753 Good 
4 58.32890 -135.806 Good 
4 58.33412 -135.731 Good 
4 58.30898 -135.722 Good 
4 58.30896 -135.741 Good 
4 58.31132 -135.749 Good 
4 58.31315 -135.722 Good 
4 58.33582 -135.742 Good 
4 58.33038 -135.801 Good 

-continued-  
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Appendix H2.–Page 2 of 2. 

Strata Latitude Longitude Status 
4 58.33586 -135.754 Good 
4 58.30918 -135.713 Good 
4 58.30552 -135.731 Good 
4 58.33251 -135.751 Good 
4 58.32465 -135.781 Good 
4 58.33320 -135.733 Good 
4 58.32700 -135.729 Good 
4 58.32667 -135.796 Good 
4 58.30988 -135.709 Good 
4 58.31897 -135.770 Good 
5 58.31509 -135.748 Extra 
5 58.31300 -135.734 Extra 
5 58.31638 -135.717 Extra 
5 58.31203 -135.741 Good 
5 58.32189 -135.733 Good 
5 58.32426 -135.751 Good 
5 58.32042 -135.741 Good 
5 58.32578 -135.760 Good 
5 58.30947 -135.730 Good 
5 58.32211 -135.741 Good 
5 58.32564 -135.777 Good 
5 58.32665 -135.774 Good 
5 58.31649 -135.723 Good 
5 58.31491 -135.736 Good 
5 58.32967 -135.767 Good 
5 58.31659 -135.745 Good 
5 58.32840 -135.775 Good 
5 58.32345 -135.772 Good 
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